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This book is a FREE document written by Philip and Stephanie Walmsley from 

www.softpro.co.nz 

Please feel free to share and distribute this book. You can email it, post it on 

your blog, tweet about it, link to it from Facebook and share it with whoever 

you think would be interested. 

The document must be unaltered and complete along with our names, 

copyright notice and link: www.softpro.co.nz 

 

©2010 Copyright Softpro Limited. All rights reserved. 

 

DISCLAIMER AND/OR LEGAL NOTICES: 

The authors of this book have attempted to make the information in this book 

as accurate as possible.  However, the information in this book is for personal 

educational use only and is provided in good faith without any express or 

implied warranty. Where the authors have provided hypertext links to other 

web sites, this is done as a service to users of this book. This service does not 

mean that the authors endorse those sites or material on them in any way. 

 

http://www.softpro.co.nz/
http://www.softpro.co.nz/
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Softpro has been providing IT support and management 

services to small businesses in New Zealand since 1999 

 

Softpro offers three types of services to its clients. 

 

This service is suited to clients who are looking for a responsive, professional, 

and reliable IT support resource available to them when the need arises, but 

don‘t necessarily need or want on-going management services. On Demand 

Support Services are priced on a per-incident or hourly basis. 

 

This service provides you with proactive, on-going monitoring, management, 

support and planning of your IT systems, as well as support for those using 

the systems.  This service is priced on a flat monthly fee – providing budget 

predictability and ease of access to our services. 

 

This service is suitable for any company at all, with up to thirty users.  It is a 

completely automated, totally reliable, economical and practical backup 

service.  Find out more here: http://www.cloudbackup.co.nz/ . 

 

Contact Softpro: 

Email: philip@softpro.co.nz 

Tel:  950 3675 

Mobile: 021 763 741 

 

http://www.cloudbackup.co.nz/
mailto:philip@softpro.co.nz
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How many times have you wanted to send an Excel report to a business 

associate or co-worker, and you end up sending them the entire spreadsheet 

as an attachment? 

Have you seen how big these spreadsheets can get? 

You might also want to hide some of the data, and still make it easy for the 

recipient to read the report. Here is a simple way to make everyone happy. 

Just follow the steps and you can send professional reports in no time! 

 

Step 1 Create the report and format it. (e.g. use autoformat). You can also 

use the toolbar icon for this step. 

 

Step 2 The next step is to choose SEND TO from the FILE menu. Select the 

option MAIL RECIPIENT – this is the key to sending only the report.  

 

Step 3 You might see an option asking if you want to send the entire 

worksheet or only the page – choose SEND THE CURRENT SHEET 

AS THE MESSAGE BODY.  

 

Step 4 Once you choose this option, you will see an address, subject and 

message entry; add this information – there is plenty of room. 

 

Step 5 When you are ready to send it, click SEND THIS PIVOT TABLE 

REPORT. 
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When you tell Word to include page numbers in your headers or footers, Word 

starts numbering from page 1 and displays Arabic numerals such as 1, 2, 3, 

etc. 

If you want to number your pages differently (for example, numbering them as 

i, ii, iii, or a, b, c), or if you want Word to make 39 the first page number in your 

document, you have to use the Page Number Format button on the Header 

and Footer toolbar. 

To use the Page Number Format button, follow these steps: 

 On the View drop-down menu, choose Header and Footer.   

 Highlight the page number text box that appears in your Header (or 

Footer).  The page number appears shaded grey. 

 If page numbers do not appear in your Header (or Footer), click the 

Insert Page Number button on the Header and Footer toolbar, and 

then highlight the number that appears. 

 Click the Format Page Number icon on the Header and Footer toolbar.  

The Page Number Format dialog box appears, offering ways to 

change the number display or numbering in your header or footer. 

 Click in the Number Format list box and choose a page numbering style 

(such as 1, 2, 3 or i, ii, iii). 

 In the Page Numbering group, click one of the radio buttons. 

 Click OK. 
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This time-saving function automatically fills in commonly used word and 

number sequences for you – so you don‘t have to!  The secret to AutoFill is 

the tiny, black square on the bottom right-hand corner of your active cell or a 

consecutive series of highlighted cells. This is called the fill handle. 

Now say you want to enter the numbers 1 to 25 in a column. Instead of typing 

this in manually, you can enter 1 in the first cell and 2 in the second cell. Then 

highlight both cells and click on and drag the fill handle down to the twenty-

fifth cell. Let go of your mouse button, and voila!  This works the same for 

other numbered sequences (e.g. odd numbers, multiples of 25) or number 

values, such as dates or units of time.  Just remember to fill in and highlight 

the first two cells so that Excel recognises the numerical pattern you want.  It 

also works the same if you want to fill cells across a row. 

Common terms such as months or days of the week can also be AutoFill-ed – 

just type ―January‖ in the first cell, grab your fill handle and drag down or 

across to have the program automatically fill in the other months for you. 

If you want to fill in non-standard terms that you use often (eg. products or 

employees), first create a custom list: 

 choose Tools -> Options -> Custom Lists (in Excel 2003) 

 or Excel Options -> Popular -> Edit Custom List (in Excel 2007) 

 type your list in the ―List entries‖ window and click Add. 
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Ever want to speed up your Internet browsing? Here are a few tips and tricks 

to just speed up your web surfing and managing your tabs on IE7 and Firefox. 

 

 Middle click Opens the link in a new tab 

 Ctrl + click Opens the link in a new tab 

 Right click and select  ―Open Link in New Tab‖ 
 

 Shift + click Opens the link in a new window 

 Right click and select  ―Open Link in New Window‖ 
 

 Ctrl + T Opens a new Tab 

 Ctrl + Shift + T Re-opens the last closed tab 
 

 Ctrl + scroll wheel Zooms 

 Ctrl + +/- buttons Zooms 
 

 Alt + D Moves the curser to the address bar 

 Ctrl + Tab Cycles through the tabs 

 Ctrl + Shift + Tab Cycles through the tabs in reverse 

 F11 Puts the browser in/out of full screen mode 
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What would you do if a fire or natural disaster struck tomorrow and you lost all 

your vital business data?  Are you simply relying on tape back-ups, which fail 

to restore data as much as 60% of the time? 

Consider the reality that most small businesses have been operating in the 

dark ages in terms of data protection; and some business owners have learnt, 

to their cost, that no back up means no protection, means no business. 

Disaster Recovery is the buzz word describing the back up plan that a 

company has in place.  Having a Disaster Recovery plan protects your 

business from loss or damage.  

Backing up your critical data is not only affordable for small business, it is 

crucial.  Things like theft or vandalism, a hardware failure, a fire in your office 

building or a flood are events that happen somewhere in New Zealand every 

day, and any single one of these disasters could destroy an unprotected 

business. 

CloudBackup (www.cloudbackup.co.nz) is a state-of-the-art, fully-automated 

back-up solution.  It is much more cost effective and affordable than you think.  

And when you think about it – can any company afford to be without a DR 

plan? 

 

www.cloudbackup.co.nz
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Make it lengthy. Each character that you add to your password increases the 

protection that it provides many times over. Your passwords should be 8 or 

more characters in length; 14 characters or longer is ideal. 

 

Combine letters, numbers, and symbols. The greater variety of characters 

that you have in your password, the harder it is to guess. 

 

Use the entire keyboard, not just the most common characters. Symbols 

typed by holding down the "Shift" key and typing a number are very common 

in passwords. Your password will be much stronger if you choose from all the 

symbols on the keyboard, including punctuation marks not on the upper row of 

the keyboard, and any symbols unique to your language. 

 

Use words and phrases that are easy for you to remember, but difficult 

for others to guess. The easiest way to remember your passwords and pass 

phrases is to write them down. Contrary to popular belief, there is nothing 

wrong with writing passwords down, but they need to be adequately protected 

in order to remain secure and effective. 

 

In general, passwords written on a piece of paper or in a book are more 

difficult for hackers to compromise across the Internet than those stored in a 

password manager, on a Web site, or in some other software-based storage 

tool, such as Excel or Word.  Any software you use for this purpose must use 

a ―master‖ password to encrypt its password store.  Also, if you do use paper, 

you need to keep it hidden so that your passwords are not compromised by 

visitors or colleagues. (i.e. don‘t use a Post-It note stuck on your computer 

monitor ) 

 

* ideas here came from http://www.microsoft.com/protect/yourself/password/create.mspx  
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In Outlook, you can create templates that contain text that you send over and 

over again to your address book contacts. You can compose and save a 

message as a template, and then use that template whenever you need it.  

Just add any new or personalised text before you send the message.  (N.B. 

You can’t create an Outlook template if you are using MS Office Word as your 

e-mail editor. To make sure you are not using Word as your e-mail editor, click 

the Tools menu in Outlook, click Options, and then click the Mail Format tab. 

Clear the check box next to Use Microsoft Office Word 2003 to edit e-mail 

messages.)  

Create a mail template  

1. In Outlook, on the File menu, point to New, and then click Mail 

Message.  When the new message opens, give it an appropriate 

subject and compose your content. Leave space for personalised 

information that you'll add when you send the message to a particular 

recipient.  

2. On the File menu, click Save As.  

3. In the Save as type list, select Outlook Template, and then click 

Save.  

4. Close the message that you used to create your template. If you are 

prompted to save the message, click No.  

Send a message using your template  

1. From the Outlook Inbox, click the Tools menu, click Forms, and then 

click Choose Form.  

2. Click the Look In box, and select User Templates in File System from 

the drop-down list.  

3. Select the template that you created in Step 1, and then click Open.  

4. Personalise the message if you want to, add the recipient's e-mail 

address to the To line, and then click Send. 

 
*  ideas here came from http://www.microsoft.com 

http://www.microsoft.com/
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Do you ever wish you could add or remove buttons on your toolbar? This is 

quite a simple thing to do and you then have your own personal set up which 

pleases you and helps you work faster and more comfortably. 

To add a button to a toolbar:  

 Choose Toolbars from the View menu.  

 Select Customize.  

 Click on the Commands tab.  

 Select an item under Categories.  

 Select an item from the list of Commands.  

 Drag the command to a toolbar. An "I" beam will appear to help you 
install the button. By default, the new button has only a text label.  

 Right-click on the new Toolbar item.  

 Select Default Style (the button will become a plain square).  

 Right click on the new Toolbar item again.  

 Choose Change Button Image, then select a button image.  

 Close the Customize dialog box. 

To remove a button:  

 Choose Toolbars from the View menu.  

 Select Customize.  

 Drag the button you want to remove off the toolbar. 

 To make your own toolbar:  

 Choose Toolbars from the View menu.  

 Select Customize.  

 Click on the Toolbars tab, then click on the New button.  

 Give the toolbar a name.  
 

You can also choose to make this toolbar available to the Normal template (all 

documents) or the current document only. A small toolbar palette will appear 

on the screen. Click on the Commands tab, select a Category, then drag the 

commands you want onto your new toolbar. 
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Your laptop is an investment and if you take reasonable and sensible 

precautions it will work hard for you and be reliable. Here are a couple of 

simple tips to protect your investment in everyday use. 

 

 Keep food and drink away from your laptop and always have clean 

hands when using your laptop.  

 Close the lid gently and holding from the middle. Closing the lid using 

only one side causes pressure on the hinge and can cause it to bend 

and snap.  

 Hold and lift the computer by its base, not by its LCD display (screen).  

 Plug accessory devices into their proper slots. Always look at the 

symbols on the laptop carefully before inserting devices. Jamming a 

phone line into an Ethernet port or vice versa could damage the 

sockets, making it impossible to use them again.  

 Check to see if labels are affixed securely before inserting media into 

your laptop computer. Never insert undersized CDs, as these can 

damage the disk player permanently.  

 Don't expose your laptop to rapid temperature fluctuations. When 

bringing your laptop indoors during winter, don't turn it on immediately. 

Instead, let it warm to room temperature first. This will avoid any 

potential for damage to the disk drive from condensation forming inside 

the machine.  

 Don't leave your laptop in a car. Not only do the insides of cars 

experience large temperature swings that could damage a laptop, but a 

laptop (or laptop bag) is an inviting target for a smash and grab thief.  

 Have the unit cleaned once a year to remove internal dust. Get this 

done by a computer professional. If dust accumulates, the system 

cannot cool itself correctly. Heat can destroy the motherboard.  

 Look into getting a laptop bag. Many breaks happen because of laptops 

being dropped or bumped. A bag greatly reduces the risk of damage. 
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HARDWARE:  Buying on line or buying a computer on a special offer from a 

retailer may look like a fabulous bargain to a business owner, especially when 

the price is compared with what the business owner‘s IT specialist is 

recommending or offering. However it‘s important to consider exactly what you 

are getting for your money before choosing what appears to be the cheaper, 

so more sensible option. 

 

There are two aspects to consider when buying.  The first thing is the quality 

of the computer you are buying and the second is the software. Most 

equipment is made for either the retail or the business market.  The retail 

market equipment is more lightly built, it doesn‘t have the strength and stability 

of business equipment and you don‘t usually get such a high quality of service 

from the supplier with home equipment. 

 

The guarantee on business equipment is more substantial and can be longer 

than that on a retail machine.  For example, if your business laptop has a 

problem you may have a three year, on-site guarantee.  Your retail laptop may 

simply have a one year, return to base warranty. 

 

All this means that your on-line bargain may not be such a bargain after all, 

and your local IT specialist is giving you reliable advice when he recommends 

a business machine which might be more expensive in the short term, but 

which will likely have a lower TCO (lower cost of ownership). 

 

The second consideration is software, which is also different for a business 

machine, and I‘ll tell you more about that on the next page. 
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SOFTWARE:  When you buy a retail system, either on line or from a retailer, 

the licence you buy is what is known as an OEM licence.  This stands for 

‗Original Equipment Manufacturer‘ and it is not a transferable software licence.  

The software licence belongs to the computer and not to the owner of the 

computer. 

Why might you want a transferable software licence? If, for example, the 

system is stolen then you lose the licence as well as the computer.  If you 

upgrade your system and sell some equipment the software licence goes with 

the computer. 

But what if you decide to keep your computer and upgrade the software?  

Well with OEM, the only upgrade you can get is a retail upgrade and this 

usually costs more. 

Also, the software package that comes with a home computer might not have 

all the software you need.  For example, you might get Office Small Business 

Edition, but that does not include MS Access, and if your business uses 

Access to run a particular programme you might encounter problems that 

make your retail bargain less appealing. 

When buying software for your business, you need to ensure that you get an 

―Open Value‖ licence.  This means that you then own the software licence and 

you can move it from machine to machine without a problem.  

With an Open Value licence you can also add Software Assurance which 

gives you free software upgrades for three years (extendable for a further 

three years) and best of all, the cost for these licences and upgrades can be 

spread over the whole six years. This is a better proposition for business 

owners who will see a reduction in the Total Cost of Ownership (TCO) 

compared to the OEM/Retail upgrade approach. 

If you need help to make a decision on what software or hardware to choose 

for your business, contact philip@softpro.co.nz for unbiased, professional 

advice. 

mailto:philip@softpro.co.nz


 

www.softpro.co.nz ©2010 Softpro Ltd 15 

 

 

The ability to track the edits and insert comments in a document is one of 

Word‘s most useful features. In multi-user environments, it is an easy and 

effective way to collaborate and comment on document drafts, without the 

hassle and waste of paper copies of the document. This can be especially 

handy when the collaboration is taking place via email.  

To turn on the tracking: 

 Open your document then, 

 Click on Tools.  Click on Track Changes 

 Any edits you make on the document will show up in a different 

colour in the right hand margin. 

To make a comment:  

 Choose the text you would like to comment on then, 

 Click on Insert.  Click on Comment. 

 Start typing in the little coloured balloon box in the right hand 

margin. 

To make changes to any of the change tracking features: 

 Click on Show and click on the choices there. 
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Using a business computer at work means that more than one person may 

have access to the machine.  One way of ensuring privacy is to have a 

separate log-in for each user.  Another way is to protect the document rather 

than the whole machine.  You can do this by putting a password on a single 

document so that only those who have the password can read the document. 

Here‘s how. 

When you have your document open: 

 Click Tools  -  Click Options 

 Choose the Security tab 

 Enter a password that will be required to open the document. Make 

sure it‘s a password you can remember! If you have a bad memory 

for that kind of thing, write the password down somewhere. 

 Click OK and you‘re done!  

If you only want to stop people from changing the document (i.e. make it read-

only), then do this when your document is open: 

 Click Tools  -  Click Protect Document… 

 On the right-hand side of the screen, under 2. Editing Restrictions, 

 Click the check box and then click Yes, Start Enforcing 

Protection. Enter a password that will be required before you can 

make changes to the document. 

 Remember this password too! 

 You‘re done!  

These procedures are virtually identical in Excel. 
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Here are a few keyboard shortcuts that will make a lot of day to day 

operations easier and faster. 

 

On a MAC In Windows Operation 

Command + A CTRL + A Select all 

Command + C CTRL + C Copy selected text or file 

Command + X CTRL + X Cut selected text or file 

Command + V CTRL + V Paste text or file 

Command + Z CTRL + Z Undo last action 

~~~ CTRL + B Make Selected text bold 

~~~ CTRL + I Make selected text italic 

~~~ CTRL + U Underline selected text 

Command + | CTRL + E Align selected text to the centre 

Command + } CTRL + R Align selected text to the right 

Command + { CTRL + L Align Selected Text to the Left 

~~~ CTRL + J Align selected text to the justified 
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The Character Map program in Windows lets you add weird foreign 

characters, such as à, ß or even Ħ into your document. 

To get there: (in XP), click Start, Programs, Accessories, System Tools, 

Character Map; (in Vista/Win7), type ‗char‘ in the search box on the start 

menu and press Return. Then, follow these steps: 

1. Make sure that the current font — the name for the style of the 

characters on the page — shows in the Font box. If the current font 

is not showing, click the down arrow and click the font when it 

appears in the drop-down list. 

2. Scan the Character Map box until you see the symbol you're after; 

then double-click on that character. The symbol appears in the 

Characters to Copy box. 

3. Click Copy to send the character to the Clipboard. 

4. Click in the document where you want the new symbol or character 

to appear. 

5. Press Ctrl+V and the new character will be inserted. (Give it a 

second. Sometimes it's slow.) 

 

The symbols in the Character Map box are easier to see if you hold down the 

mouse button and move the pointer over them. 

For some fun symbols, switch to the Wingdings font. It's got some great 

symbols to spice up your work. 

Note: You can grab several characters at a time by double-clicking each of 

them and then copying them into your document as a chunk. You don't have 

to keep returning to the Character Map for each one. 
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Deleting a Word in a Document 

If you want to delete a word you just typed that is misspelled or inappropriate, 

or if there‘s a phrase you‘d like to get rid of, then pressing the delete key over 

and over can be too time consuming. Taking the time to use the mouse to 

highlight the text can sometimes be tedious, too.  You can delete a word at a 

time quite easily. 

Simply hit control+backspace.  This will delete the whole word. 

To do this with the Mac hold the ―option key‖ down while pressing delete. This 

key is located to the left of the space bar, in between the apple key and the 

control key. Now the cursor will jump back to the previous space, one word for 

each tap on the delete key. 

 

Repeating Heading Rows in Word Tables 

In a Word table, the heading (or header) row is the first row in the table -- the 

one that usually describes what each column contains.  

It‘s very simple to make the header row repeat at the top of each new page; 

just click to put the cursor in the header row (or select the header rows if you 

have more than one) and choose "Table" in the top menu bar, then click 

"Heading Rows Repeat". 
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Every now and again, Windows goes on strike.  You click on the mouse and 

nothing happens, you look in all the significant places on the screen and 

nothing happens.  You try pressing a key and nothing happens.  So you try 

different keys, any key, all the keys.  And nothing happens. 

When you see this, don‘t panic. 

Your computer has locked up  

Try these things, in order:  

 Press Esc twice. This action usually doesn't work but try it anyway. 

 Press Ctrl, Alt, and Delete all at the same time. Hopefully, Task 

Manager appears with the message that you discovered an 

unresponsive application. Task Manager lists the names of currently 

running programs, including the one that's not responding. Click the 

name of the program that's causing the mess and then click the End 

Process button. You lose any unsaved work in that program, but you 

should be used to that.  

 If that still doesn't do the trick, click the Task Manager's Shut Down 

menu and choose Restart. 

 If none of this works, push the computer's reset button. When the Turn 

Off Computer box appears, choose Restart. 

 If not even the reset button works (and some computers don't even 

have reset buttons anymore), turn the computer off by pushing its 

power button. (If that merely brings up the Turn Off the Computer 

menu, choose Restart, and your computer should restart.) 

 When nothing else works, if you press the computer's Off button long 

enough, it will eventually stop resisting and turn off. 
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Your computer needs to be taken care of in various ways.  And just as you 

have (or should have) a ‗brush and floss‘ routine, so you need a ‗scan and 

defrag‘ routine.  

Once a month is a good rule for this; so aim for every two or three weeks.. But 

if you are having small problems with your computer operations run these two 

utilities daily for a week. There are a few things you must do before running 

Scan Disk...  

1. Shut down all programs that are running. 

2. Turn off your screen saver. 

3. Turn off or close the Office Shortcut Bar and/or the Corel DAD bar 

(down near the clock in the right hand corner of your screen).  

Now you are ready to run Scan Disk... you should always run ScanDisk first 

followed by Defrag. It will take anywhere from half an hour to an hour to 

complete these utilities, so make sure your computer is not going to be 

needed during that time. 

To Run ScanDisk 

1. Click on Start, Programs, Accessories, System Tools, Scan Disk. 

2. Make sure Drive C: is highlighted 

3. Make sure Thorough and Automatically Fix Errors are both checked. 

4. Click Start 

5. Click OK and Finish when completed. 

To run Defrag: 

1. Click on Start, Programs, Accessories, System Tools Disk 

Defragmenter. 

2. When asked Which drive do you want to Defrag?  Highlight Drive C: 

3. Click OK and if you are asked do you want to continue make sure you 

click Yes. 

4. Click OK and Finish when completed. 
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Have you ever attended a presentation where the speaker fumbled through 

PowerPoint, trying to get the presentation started? The speaker starts 

PowerPoint, searches for the file, opens the file, and finally starts the slide 

show. Talk about looking like an amateur! There's a much easier way. 

Place your PowerPoint file in an easy-to-remember, easy-to-find folder (or on 

the Desktop). Then from within Windows Explorer (or any file manager), right-

click on the file name and choose ―Show‖ (the command should be near the 

top). 

Windows launches PowerPoint and opens the presentation to the first slide in 

Slide Show mode. Using this technique you'll certainly make a better first 

impression. 

To add a slide from one PowerPoint presentation into another: 

1. Open the presentation that you would like to insert slides to. 

2. Move to the slide before the place where you would like to place the 

inserted slide. 

3. Click the ―Insert‖ menu and then select ―Slides from Files‖. 

4. Click the ―Browse‖ button. 

5. Navigate to the presentation that has the slide you want to insert. Click 

it, and click the ―Open‖ button. 

6. From the display of slides, click the slide you would like to insert. 

7. Click ―Insert‖. 

8. Select more slides to insert and click the ―Insert‖ button, or click the 

―Close‖ button. 

Extra Tip: You can click the ―Insert All‖ button to insert all the slides from the 

presentation. 



 

www.softpro.co.nz ©2010 Softpro Ltd 23 

 

 

After your very successful PowerPoint presentation you may wish to convert 

your presentation to a Microsoft Word document.  You may want to combine 

the presentation with more detailed content from elsewhere and create a 

report.  Or maybe you want to send a presentation-in-review document to your 

boss for forwarding on up the chain.  Or you might like to try creating training 

materials in Word from an existing PowerPoint content.  It is easy, and here‘s 

how to do it: 

1. Open your PowerPoint presentation and choose File, Send To, 

Microsoft (Office) Word. 

2. Select a page layout. 

3. If what you need isn't available, just choose the one closest to what you 

require; you can edit the layout later in Word. 

4. Select either the Paste or Paste Link option. The Paste option creates 

thumbnails of the slides inside Word; the Paste Link option creates 

links to the actual slides. The Paste and Paste Link options are greyed 

out if you choose the Outline Only option. 

5. Click OK and PowerPoint fires up Word. 

6. Word shows you a nicely formatted document that contains the slides 

or the outline. 

7. In Word, if you like the way things look, choose File, Save. 
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As soon as you begin to type something online -- a Web site address in 

Internet Explorer, for instance, or a name into an online form -- Windows often 

races in to help. It sends down a little box, listing items you've typed 

previously.  A quick point-and-click lets you retrieve a word or phrase from the 

handy AutoComplete list, sparing you the effort of typing it in yet again.  

Some people, however, don't like Windows looking over their shoulder as they 

type. And it's especially annoying when Windows keeps listing your 

typographical errors.  To delete a word or phrase from most AutoComplete 

drop-down lists, press the Down-arrow key to highlight the entry and then 

press the Delete key. 

Unfortunately, this trick doesn't delete individual Web addresses you type into 

Internet Explorer. You must delete Internet Explorer's History to remove those.  

To make Internet Explorer stop listing your previous entries, follow these 

steps: 

1. Open Internet Explorer and choose Internet Options from the Tools 

menu. 

2. Click the Content tab and click the AutoComplete button. The 

AutoComplete Settings dialog box opens.  

3. Click to remove check marks from Web Addresses, Forms, User 

Names and Passwords on Forms, and Prompt Me to Save Passwords.  

4. Click the Clear Forms button and the Clear Passwords button and then 

click OK. Those two final buttons delete previously stored 

AutoComplete entries.  

 

Security Note: It's convenient for Internet Explorer to store the passwords you 

use for your Web site. But that makes it convenient for anybody who sits at 

your computer to log on to password-protected sites. Even if you enjoy 

AutoComplete, consider removing the check mark from the ‗User Names and 

Passwords on Forms‘ box in Step 3. 
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What exactly does the Windows Key do on your keyboard? When used in 

combination with other keys, here‘s what you can do: 

1. Windows Key + Tab: Cycle through buttons in Task Bar 

2. Windows Key + D:  Minimise or restore all windows 

3. Windows Key + E:  Launch Windows Explorer 

4. Windows Key + F:  Launch Search for Files 

5. Windows Key + Ctrl + F:  Launch Search for Computers 

6. Windows Key + F1:  Launch the Help & Support Centre 

7. Windows Key + R:  Launch the Run dialog box 

8. Windows Key + Pause:  System Properties box 

9. Windows Key + M:  Minimizes all open windows 

10. Windows Key + Shift + M:  Undo minimize all windows 

11. Windows Key + L: Locks the workstation 

12. Windows Key + U:  Launch the Utility Manager 

13. Windows Key by itself:  Brings up Start Menu 

 

Plus, here's a few extra ones if you have Vista: 

14. Windows Key + G:  Cycle through the Sidebar Gadgets 

15. Windows Key + T:  Cycle through programs on Task Bar 

16. Windows Key + U:  Open the Ease of Access Centre 

17. Windows Key + X:  Open the Windows Mobile Centre 
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If you use a specific program on a regular basis, you can use the Task 

Scheduler Wizard to create a task that opens the program for you 

automatically according to the schedule you choose. 

For example, if you use a financial program on a certain day each month, you 

can schedule a task that opens the program automatically so you don't risk 

forgetting to open it yourself.  

1. Open Task Scheduler by clicking the Start button, clicking Control 

Panel, clicking System and Maintenance, clicking Administrative Tools, 

and then double-clicking Task Scheduler. If you are prompted for an 

administrator password or confirmation, type the password or provide 

confirmation. 

2. Click the Action menu, and then click Create Basic Task.  

3. Type a name for the task and an optional description, and then click 

Next.  

4. Do one of the following:  

 To select a schedule based on the calendar, click Daily, 

Weekly, Monthly, or One time, click Next, specify the schedule 

you want to use, and then click Next.  

 To select a schedule based on common recurring events, click 

When the computer starts, or When I log on, and then click 

Next.  

 To select a schedule based on specific events, click When a 

specific event is logged, click Next, specify the event log and 

other information using the drop-down lists, and then click Next.  

5. To schedule a program to start automatically, click Start a program, and 

then click Next.  

6. Click Browse to find the program you want to start, and then click Next.  

7. Click Finish 

 


